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Title: Power BI Fundamentals Course 

Course Duration: 4 Hours 

Module 1: Get, Transform, and Load Data in Power BI (1 hour) 

 1.1 Data Sources Connections 

 Introduction to data sources 

 Connecting to various data sources (e.g., Excel, databases, online services) 

 Data source settings and options 

 1.2 Transformations in Power BI 

 Understanding data transformations 

 Manipulating tables and columns 

 Data type conversions 

 Creating data groups 

Module 2: Modeling in Power BI (1 hour) 

 2.1 Relationships 

 Defining relationships between tables 

 One-to-one, one-to-many, and many-to-many relationships 

 Cross-filtering and cross-highlighting 

 2.2 Aggregations 

 Introduction to aggregations 

 Creating summary tables 

 Performance optimization with aggregations 

 2.3 Measures and Calculated Columns 

 Creating and using DAX (Data Analysis Expressions) 

 Measures vs. calculated columns 

 Common DAX functions 

 2.4 Date Table 

 Creating a date table 

 Importance of date tables in time-based analysis 

 Managing date hierarchies 
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Module 3: Visualizations in Power BI (1 hour) 

 3.1 Building Visualizations 

 Introduction to various visualization types (e.g., charts, tables, maps) 

 Drag and drop interface for creating visualizations 

 Customizing visual elements 

 3.2 Formatting Visuals 

 Customizing colors, fonts, and styles 

 Themes and templates 

 Adding background images 

 3.3 Interactions 

 Configuring interactions between visuals 

 Highlighting and filtering based on user interactions 

 3.4 Filters and Slicers 

 Implementing data filters 

 Creating slicers for user-controlled filtering 

 Using advanced filter options 

 3.5 Buttons and Bookmarks 

 Creating buttons for navigation 

 Using bookmarks to capture states 

 Building interactive reports and dashboards 

Module 4: Power BI Service (1 hour) 

 4.1 Publish, Export, and Share 

 Publishing reports to Power BI Service 

 Exporting reports to various formats (e.g., PDF, PowerPoint) 

 Sharing reports with others 

 4.2 Dashboards and Tiles 

 Creating dashboards 

 Pinning visuals to dashboards 

 Real-time data in dashboards 

 4.3 Power BI Service Settings 

 Overview of Power BI Service settings 

 Managing data refresh schedules 

 Collaborative features and sharing options 

This course outline covers the essential topics in Power BI and is designed to be 

completed in a 4-hour duration. It provides a solid foundation for users to start 

creating reports and dashboards with Power BI and effectively share their insights 

using the Power BI Service. 
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1.1 User Guide: Connecting to Data Sources in Power BI 

This step-by-step user guide will help you understand how to connect to data 

sources in Power BI. You'll learn how to access various data sources, including Excel 

files, databases, and online services, and explore data source settings and options. 

Step 1: Launch Power BI Desktop 

Open Power BI Desktop on your computer. You can download and install Power BI 

Desktop from the official Microsoft website if you haven't already. 

Step 2: Start a New Project 

Click on "File" in the top-left corner of the Power BI Desktop window. Select "New" to 

create a new project or "Open" if you're working on an existing project. 

Step 3: Data Sources Connections 

1. Click on the "Home" tab in the Power BI Desktop ribbon. 

2. Look for the "Get Data" button and click on it. This button is your gateway to 

connecting to various data sources. 

Step 4: Choose a Data Source 

1. A window will pop up, displaying a list of different data source categories. You can 

choose from various options, including: 

 "File" for local files like Excel, CSV, or JSON. 

 "Database" for SQL Server, MySQL, Oracle, and more. 

 "Online Services" for cloud-based services like Azure, SharePoint, and more. 

2. Select the appropriate data source category based on where your data is located. For 

this guide, we'll use "File" as an example. 

Step 5: Connect to a File Data Source (e.g., Excel) 

1. If you selected "File" in the previous step, you'll see a list of file-related options. 

Choose the type of file you want to connect to (e.g., Excel). 

2. Click "Connect" to proceed. 

Step 6: Browse and Select Your Data Source 

1. A file browser dialog will open. Navigate to the location of your data source (e.g., 

your Excel file) and select it. 

2. Click "Open" to confirm your selection. 
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Step 7: Data Source Settings and Options 

1. After selecting your data source, you may be prompted to configure settings or 

specify import options, depending on the data source type. 

2. You can set options such as data import mode (import or direct query), data range, 

and other source-specific settings. 

3. Click "Load" to load the data into Power BI or "Edit" to open the Power Query Editor 

for advanced data transformations. 

Step 8: Review and Edit Data (Optional) 

1. If you chose to edit the data, the Power Query Editor will open, allowing you to 

perform data transformations, clean the data, and apply various data source-specific 

transformations. 

2. Once you're satisfied with the data, click "Close & Apply" to load the data into your 

Power BI project. 

Step 9: Data Imported Successfully 

You have successfully connected to a data source in Power BI. Your data is now 

available for analysis, visualization, and reporting within your Power BI project. 

That's it! You've learned how to connect to various data sources in Power BI, 

including Excel, databases, and online services, and explored data source settings 

and options. You can repeat these steps to connect to additional data sources for 

your Power BI project. 
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1.2 User Guide: Data Transformations in Power BI 

This step-by-step user guide will walk you through the process of data 

transformations in Power BI. You'll learn how to manipulate tables and columns, 

perform data type conversions, and create data groups to prepare your data for 

analysis and visualization. 

Step 1: Open Power BI Desktop 

Launch Power BI Desktop on your computer if you haven't already done so. 

Step 2: Load Data 

1. Click on "File" in the top-left corner of the Power BI Desktop window. 

2. Select "Open" if you have an existing Power BI file or "Get Data" if you want to load 

data from a new source. 

Step 3: Choose a Data Source 

1. Select the appropriate data source from the available options, such as Excel, SQL 

Server, or an online service. Click "Connect" to proceed. 

Step 4: Load Data into Power BI 

1. After selecting your data source, you may be asked to specify settings or load 

options. Choose the necessary settings, and click "Load" to load the data into Power 

BI. 

Step 5: Understanding Data Transformations 

1. Once the data is loaded, you'll see it in the "Fields" pane on the right side of the 

Power BI Desktop window. This pane lists the tables and fields in your dataset. 

2. Understanding data transformations is essential. Transformations allow you to clean, 

shape, and prepare the data for analysis. 

Step 6: Manipulating Tables and Columns 

1. To manipulate tables or columns, select a table or column in the "Fields" pane. 

2. Right-click on the selected table or column and choose "Transform Data." 
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Step 7: Data Type Conversions 

1. In the Power Query Editor, you can perform various data type conversions. 

2. Select a column you want to change the data type for. 

3. Right-click on the column header and choose "Change Type." Then, select the 

desired data type (e.g., text, number, date). 

Step 8: Creating Data Groups 

1. Data groups, often called custom columns, allow you to create calculated fields 

based on existing data. 

2. In the Power Query Editor, select "Add Column" from the "Model" tab. 

3. You can create data groups by using Power Query formulas. For example, to create a 

calculated column that multiplies two existing columns, use the "Multiply" function: 

NewColumn = [Column1] * [Column2]. 

Step 9: Apply Transformations 

1. After making desired changes and creating data groups, click "Close & Apply" to 

apply the transformations to your data. 

Step 10: Review and Analyze Transformed Data 

1. Your data is now available in Power BI with the applied transformations. 

2. You can start building visualizations and reports using the prepared data. 

You've now learned how to manipulate tables and columns, perform data type 

conversions, and create data groups in Power BI to prepare your data for analysis 

and reporting. These data transformations are crucial for ensuring that your data is in 

the right format for your business intelligence needs. 
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2.1 User Guide: Defining Relationships in Power BI 

This step-by-step user guide will help you understand how to define relationships 

between tables in Power BI. You'll learn about different types of relationships, 

including one-to-one, one-to-many, and many-to-many, and how to use cross-

filtering and cross-highlighting to enhance your data analysis. 

Step 1: Open Your Power BI Project 

Launch Power BI Desktop and open your existing project or create a new one. 

Step 2: Load Data 

1. Click on "Home" in the Power BI Desktop ribbon. 

2. Select "Get Data" to load your data from various sources. 

Step 3: Load Data Tables 

1. Load multiple data tables into your Power BI project. Each table should represent a 

distinct data source or entity, such as customers, products, or sales. 

Step 4: Define Relationships 

1. In the "Fields" pane on the right side of the Power BI Desktop window, you'll see a 

list of tables and fields. 

2. To define relationships, click on the "Model" view in the left sidebar. You'll see a 

visual representation of your data model. 

Step 5: Create Relationships 

1. In the Model view, you can connect tables by dragging a field from one table and 

dropping it onto a related field in another table. 

2. You'll see a line connecting the two fields, indicating a relationship. 

Step 6: Choose Relationship Type 

1. When creating relationships, you can specify the relationship type: 

 One-to-one: When one record in one table matches with one record in 

another. 

 One-to-many: When one record in one table matches with multiple records in 

another. 

 Many-to-many: When multiple records in one table match with multiple 

records in another (requires an intermediary table). 
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Step 7: Define Cross-Filtering 

1. Cross-filtering allows data in one visual to filter data in another visual based on the 

defined relationships. 

2. In a report page, add multiple visuals (e.g., tables, charts). 

3. Apply filters to one visual, and you'll notice that other visuals automatically update 

based on the filtering. 

Step 8: Enable Cross-Highlighting 

1. Cross-highlighting allows you to highlight data in one visual to see its impact on data 

in other visuals. 

2. Select a data point in one visual, and other visuals will dynamically highlight data 

associated with the selected point. 

Step 9: Test Relationships and Interactions 

1. In your report page, test the relationships, cross-filtering, and cross-highlighting by 

interacting with visuals. 

2. Observe how changing selections in one visual affect the data in other visuals. 

Step 10: Save and Publish Your Report 

1. Once you've defined and tested relationships, saved your report, and are satisfied 

with the interactions, save your Power BI project. 

2. You can then publish your report to the Power BI Service to share it with others. 

Congratulations! You've learned how to define relationships in Power BI, including 

one-to-one, one-to-many, and many-to-many relationships, and how to use cross-

filtering and cross-highlighting to enhance your data analysis. These relationships 

and interactions are crucial for creating meaningful and interactive reports and 

dashboards in Power BI. 
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2.2 User Guide: Working with Aggregations in Power BI 

This step-by-step user guide will walk you through the process of working with 

aggregations in Power BI. You'll learn the basics of aggregations, how to create 

summary tables, and how to optimize performance using aggregations. 

Step 1: Open Your Power BI Project 

Launch Power BI Desktop and open your existing project or create a new one. 

Step 2: Load Data Tables 

1. Load your data tables into your Power BI project. This data should contain the 

detailed information you want to aggregate. 

Step 3: Understand Aggregations 

1. Aggregations are used to summarize and aggregate data, often used to speed up 

performance when dealing with large datasets. 

Step 4: Create Summary Tables 

1. In the "Fields" pane on the right side of the Power BI Desktop window, right-click 

your data table and select "New measure" to create a summary table. 

2. Write DAX (Data Analysis Expressions) formulas to calculate aggregations. For 

example, you can create measures for calculating total sales, average price, or 

maximum order quantity. 

Step 5: Define Relationships to Summary Tables 

1. To optimize performance, establish relationships between your summary tables and 

other data tables. 

2. In the "Model" view, drag and drop fields to create relationships between summary 

tables and the detailed tables. 

Step 6: Create Visuals with Aggregations 

1. On your report page, create visuals such as tables, charts, or graphs. 

2. Drag and drop the summary measures you've created onto the visuals to display the 

aggregated results. 
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Step 7: Test Performance 

1. Compare the performance of your report with and without aggregations. You should 

notice significant improvements in query speed when using aggregations. 

Step 8: Optimize Aggregations 

1. In the "Model" view, you can configure aggregation options to further optimize 

performance. 

2. Specify which measures should be stored as aggregations, what data granularity they 

should cover, and more. 

Step 9: Save and Publish Your Report 

1. Once you've created and optimized your aggregations, save your Power BI project. 

2. You can then publish your report to the Power BI Service to share it with others. 

Step 10: Monitor and Maintain 

1. Regularly review the performance of your report in the Power BI Service. 

2. Adjust aggregations and summary tables as needed to ensure optimal performance 

as your data evolves. 

You've now learned how to work with aggregations in Power BI. This knowledge will 

help you summarize and aggregate your data efficiently, leading to improved query 

performance and more responsive reports and dashboards. 
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2.3 User Guide: Working with Measures and Calculated Columns in Power BI 

This step-by-step user guide will help you understand how to work with measures 

and calculated columns in Power BI. You'll learn about creating and using DAX (Data 

Analysis Expressions), the differences between measures and calculated columns, and 

common DAX functions. 

Step 1: Open Your Power BI Project 

Launch Power BI Desktop and open your existing project or create a new one. 

Step 2: Load Data Tables 

1. Load your data tables into your Power BI project. These tables should contain the 

data you want to analyze. 

Step 3: Understand Measures and Calculated Columns 

1. Measures are calculations performed on data at the visual level, usually in a chart or 

table. They are dynamic and change based on user interactions. 

2. Calculated columns are created at the data model level and add new columns to 

your data. They are static and don't change with user interactions. 

Step 4: Create a Measure 

1. In the "Fields" pane on the right side of the Power BI Desktop window, right-click 

your data table and select "New measure" to create a measure. 

2. Write a DAX formula for the measure. For example, you can create a measure to 

calculate total sales. 

Step 5: Create a Calculated Column 

1. In the "Model" view, right-click your data table and select "New column" to create a 

calculated column. 

2. Write a DAX formula for the calculated column. For example, you can create a 

calculated column to concatenate two text fields. 

Step 6: Understand Common DAX Functions 

1. DAX functions are used in measures and calculated columns to perform calculations 

on data. 

2. Common DAX functions include SUM, AVERAGE, COUNT, MAX, MIN, IF, SWITCH, 

RELATED, and more. 
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Step 7: Create Visuals with Measures 

1. On your report page, create visuals such as charts, tables, or graphs. 

2. Drag and drop the measures you've created onto the visuals to display the calculated 

results. 

Step 8: Use Calculated Columns in Data Tables 

1. Calculated columns are available in your data tables and can be used like regular 

columns. 

2. You can filter, group, or sort data based on the values in calculated columns. 

Step 9: Test and Interact with Measures 

1. Interact with your report visuals to see how measures respond to user interactions. 

Measures update dynamically. 

Step 10: Save and Publish Your Report 

1. Once you've created measures and calculated columns, save your Power BI project. 

2. You can then publish your report to the Power BI Service to share it with others. 

You've now learned how to work with measures and calculated columns in Power BI. 

These techniques enable you to perform calculations and create new data elements 

within your reports, enhancing the depth of analysis and visualization capabilities. 
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2.4 User Guide: Creating and Managing Date Tables in Power BI 

This step-by-step user guide will walk you through the process of creating and 

managing date tables in Power BI. You'll learn how to create a date table, understand 

the importance of date tables in time-based analysis, and manage date hierarchies 

for more effective reporting. 

Step 1: Open Your Power BI Project 

Launch Power BI Desktop and open your existing project or create a new one. 

Step 2: Load Your Data Tables 

1. Load your data tables into your Power BI project. Ensure that your data includes date 

or time-related information. 

Step 3: Create a Date Table 

1. In the "Model" view, right-click in the empty space and select "New table" to create a 

new table. 

2. Name the table "Date" or a similar name that identifies it as a date table. 

Step 4: Generate Dates in the Date Table 

1. To populate the date table, you can use Power Query's "Enter Data" feature or write 

DAX code to generate a list of dates. 

2. For example, you can use DAX's CALENDAR function to create a range of dates 

based on your data's time span. 

Step 5: Create Relationships with Other Tables 

1. In the "Model" view, define relationships between the date table and other data 

tables in your model. 

2. Connect the date table to tables that contain date-related information, such as sales 

or events. 

Step 6: Use Date Table in Time-Based Analysis 

1. Date tables are crucial for time-based analysis. You can use date-related calculations 

and aggregations with ease when you have a dedicated date table. 

2. Create time-based visuals, such as line charts, to analyze trends, seasonality, and 

other time-related insights. 
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Step 7: Utilize Date Hierarchies 

1. Date hierarchies allow you to drill down into time-based data. They are automatically 

created when you have a date table. 

2. In visuals, you can expand and collapse date hierarchies to view data at various levels 

(e.g., year, quarter, month, day). 

Step 8: Customize Date Hierarchies (Optional) 

1. You can customize date hierarchies by adding or removing levels as needed. 

2. To do this, right-click the date hierarchy in a visual and select "Manage hierarchies." 

Step 9: Save and Publish Your Report 

1. Once you've created and linked your date table, save your Power BI project. 

2. You can then publish your report to the Power BI Service to share it with others. 

You've now learned how to create and manage date tables in Power BI. Date tables 

are essential for time-based analysis and enable you to explore and visualize your 

data in a meaningful way. They provide the foundation for understanding trends and 

patterns in your data over time. 
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3.1 User Guide: Building Visualizations in Power BI 

This step-by-step user guide will help you understand how to create visualizations in 

Power BI. You'll learn about various types of visualizations, the drag-and-drop 

interface for creating them, and how to customize visual elements to effectively 

convey your data. 

Step 1: Open Your Power BI Project 

Launch Power BI Desktop and open your existing project or create a new one. 

Step 2: Load Data Tables 

1. Ensure you've loaded the necessary data tables into your Power BI project. 

Visualizations rely on data. 

Step 3: Understand Visualizations 

1. Visualizations are graphical representations of your data, such as charts, tables, maps, 

and more. 

2. Different types of visualizations are suitable for various data analysis needs. 

Step 4: Create a Visualization 

1. On a report page, click on the "Visualizations" pane on the right side of the Power BI 

Desktop window. 

2. Select the type of visualization you want to create (e.g., bar chart, pie chart, table). 

Step 5: Drag and Drop Data Fields 

1. In the "Visualizations" pane, you'll see a "Fields" well. Drag and drop the appropriate 

data fields (e.g., categories, values) onto the relevant areas of the visualization. 

2. For example, to create a bar chart, drag a category field to the "Axis" area and a value 

field to the "Values" area. 

Step 6: Customize Visual Elements 

1. Use the "Format" and "Visualizations" panes to customize your visualizations. 

2. You can adjust properties like colors, fonts, labels, data labels, legends, and more. 

Step 7: Add Titles and Legends 

1. It's important to add titles to your visualizations and provide context to viewers. 

2. You can also enable or disable legends to make the visual more informative. 
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Step 8: Interact with Visualizations 

1. Test your visualizations by interacting with them. You can filter, slice, drill down, and 

cross-highlight data using the visualizations. 

Step 9: Save Your Report Page 

1. Save your report page to keep a record of your visualization. 

Step 10: Publish Your Report 

1. Once you've created and customized your visualizations, save your Power BI project. 

2. Publish your report to the Power BI Service if you want to share it with others. 

You've now learned how to create visualizations in Power BI, ranging from charts and 

tables to maps and more. These visualizations help you present your data in a 

visually appealing and informative manner, making it easier to derive insights and 

share your findings with others. 
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3.2 User Guide: Formatting Visuals in Power BI 

This step-by-step user guide will help you understand how to format visuals in Power 

BI. You'll learn how to customize colors, fonts, and styles, use themes and templates, 

and add background images to make your reports visually appealing. 

Step 1: Open Your Power BI Report 

Launch Power BI Desktop and open your report or create a new one. 

Step 2: Select a Visual to Format 

1. Click on the visual that you want to format on your report page. The selected visual 

will be highlighted. 

Step 3: Customize Colors, Fonts, and Styles 

1. In the "Visualizations" pane on the right, select the "Format" icon (paint roller). 

2. In the "Format" pane, you can customize various aspects of the selected visual: 

 Colors: Change the color palette for elements like data points, backgrounds, 

and borders. 

 Fonts: Modify the font size, family, and formatting for titles, labels, and data. 

 Styles: Adjust visual-specific styles, such as data label positions, line styles, or 

marker shapes. 

Step 4: Apply Themes and Templates 

1. Power BI offers pre-designed themes and templates to quickly change the look and 

feel of your entire report. 

2. Click on the "View" tab in the Power BI Desktop ribbon. 

3. Select "Themes" to apply a theme or "Templates" to apply a template to your report. 

Step 5: Add Background Images 

1. To add a background image to your report, click on "View" in the Power BI Desktop 

ribbon. 

2. Select "Page View" to access the page view. 

3. In the "Format" pane, expand the "Page background" section. 

4. Enable "Page background" and choose an image as your background. 
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Step 6: Apply Background to Specific Visuals (Optional) 

1. You can also set specific visuals to have background images. 

2. In the "Format" pane for the visual, expand the "Background" section and enable the 

background image. 

Step 7: Test and Review 

1. After customizing the visuals, use the "View" mode to review your report's 

appearance and check how the changes affect the visualizations. 

Step 8: Save Your Report 

1. Once you're satisfied with the formatting, save your Power BI report. 

Step 9: Publish Your Report 

1. If you want to share your formatted report with others, publish it to the Power BI 

Service or save it as a PDF or other export format. 

By following these steps, you can effectively format your visuals in Power BI, creating 

visually appealing and informative reports. Customizing colors, fonts, styles, using 

themes and templates, and adding background images allow you to convey your 

data insights in a way that suits your specific needs and branding. 
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3.3 User Guide: Configuring Interactions in Power BI 

This step-by-step user guide will help you understand how to configure interactions 

between visuals in Power BI. You'll learn how to enable highlighting and filtering 

based on user interactions to make your reports more interactive and insightful. 

Step 1: Open Your Power BI Report 

Launch Power BI Desktop and open your report that contains multiple visuals. 

Step 2: Identify Visuals for Interaction 

1. In your report, identify the visuals that you want to interact with one another. These 

visuals should have related data and be suitable for highlighting and filtering. 

Step 3: Enable Interactions 

1. Click on the visual that you want to act as the source for interactions (the one that 

triggers actions). 

2. In the "Visualizations" pane on the right, select the "Format" icon (paint roller). 

3. In the "Format" pane, expand the "Interactions" section. 

Step 4: Define Interactions 

1. In the "Interactions" section, you will see a list of other visuals in your report. 

2. Click on the icons (e.g., a paintbrush) next to each visual to define the interaction 

type: 

 "None": The source visual won't interact with the selected visual. 

 "Filter": The source visual will filter the selected visual, showing only relevant 

data. 

 "Highlight": The source visual will highlight related data in the selected visual. 

Step 5: Test Interactions 

1. Switch to the "View" mode to test the configured interactions. 

2. Interact with the source visual (e.g., click on a data point, slice a category) and 

observe how the selected visual responds based on the interaction type you defined. 

Step 6: Configure Additional Interactions 

1. Repeat the above steps to configure interactions for other visuals in your report, if 

necessary. 

2. You can set up different types of interactions to create more complex and 

informative reports. 
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Step 7: Save Your Report 

1. Once you've configured interactions to your satisfaction, save your Power BI report. 

Step 8: Publish Your Report 

1. If you want to share your interactive report with others, publish it to the Power BI 

Service or save it in a shareable format (e.g., PDF). 

By following these steps, you can effectively configure interactions between visuals in 

Power BI, allowing users to explore data, filter, and highlight information in an 

interactive and dynamic manner. This enhances the usability and insights gained 

from your reports. 
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3.4 User Guide: Using Filters and Slicers in Power BI 

This step-by-step user guide will help you understand how to use filters and slicers in 

Power BI. You'll learn how to implement data filters, create slicers for user-controlled 

filtering, and leverage advanced filter options for a more interactive report. 

Step 1: Open Your Power BI Report 

Launch Power BI Desktop and open your report with the data you want to filter and 

slice. 

Step 2: Identify Visuals for Filtering 

1. In your report, identify the visuals and data that you want to filter. 

Step 3: Implement Data Filters 

1. Click on the visual you want to filter, and select the "Visualizations" pane on the right. 

2. In the "Visualizations" pane, click on the "Filters" icon (funnel). 

Step 4: Create a Filter 

1. In the "Filters" pane, you can add or configure filters for the selected visual. 

2. Add filter conditions, such as selecting specific data points, setting a range, or using 

relative date filtering. 

Step 5: Test the Filter 

1. Switch to the "View" mode to test the filter. 

2. Interact with the filter options to see how they affect the data displayed in the visual. 

Step 6: Create Slicers for User-Controlled Filtering 

1. In the "Visualizations" pane, click on the "Slicer" icon to add a slicer visual to your 

report. 

Step 7: Configure Slicer Fields 

1. In the "Visualizations" pane, select the slicer visual. 

2. In the "Fields" well on the right, choose the fields you want to use as slicers. 

3. You can select multiple fields for slicers, and users can switch between them. 
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Step 8: Test Slicer Functionality 

1. Switch to the "View" mode to test the slicer functionality. 

2. Interact with the slicers to filter the data displayed in other visuals on the report 

page. 

Step 9: Utilize Advanced Filter Options (Optional) 

1. To enhance filtering capabilities, you can use advanced options like relative date 

filtering, top N filtering, or custom filter conditions. 

2. Access these advanced filter options through the "Filter" pane in the "Visualizations" 

pane or the "Edit interactions" feature in the "Format" pane. 

Step 10: Save Your Report 

1. Once you've implemented filters and slicers to your satisfaction, save your Power BI 

report. 

Step 11: Publish Your Report 

1. If you want to share your filtered and slicer-enabled report with others, publish it to 

the Power BI Service or export it to a shareable format (e.g., PDF). 

By following these steps, you can effectively implement data filters and create slicers 

in Power BI. This allows you and your report viewers to control and explore the data 

interactively, making it easier to gain insights and customize the report based on 

specific needs. 
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3.5 User Guide: Creating Interactive Reports with Buttons and Bookmarks in Power BI 

This step-by-step user guide will help you understand how to create interactive reports and 

dashboards in Power BI using buttons and bookmarks. You'll learn how to create navigation 

buttons, use bookmarks to capture different states, and build interactive reports for a more 

engaging experience. 

Step 1: Open Your Power BI Report 

Launch Power BI Desktop and open your report or create a new one. 

Step 2: Identify Navigation Points 

1. Review your report and identify areas where you want to create navigation points or interactive 

elements. 

Step 3: Create Navigation Buttons 

1. In the "Home" tab of the Power BI Desktop ribbon, click on "Buttons" in the "Visualizations" 

group. 

2. Choose the type of button you want to use, such as a blank button or an icon button. 

3. Place the button in your report where you want it to appear. 

Step 4: Configure Button Actions 

1. Select the button you've added to your report. 

2. In the "Visualizations" pane, you'll find the "Button Text" section. 

3. Use the "Action" dropdown to specify what the button should do when clicked. Common actions 

include: 

 "Back" to navigate to the previous page. 

 "Page navigation" to move to a specific page in your report. 

 "Bookmark" to activate a bookmark. 

Step 5: Use Bookmarks to Capture States 

1. Create a bookmark for each report state you want to capture. 

2. Go to the "View" tab and click on "Bookmarks" to open the bookmarks pane. 

3. Click on "Add a bookmark" to create a new bookmark. 

Step 6: Define Bookmark State 

1. With the new bookmark selected in the bookmarks pane, configure the state you want to 

capture. This includes the following settings: 

 The visuals you want to show or hide. 

 The page you want to navigate to. 

 Filters, slicers, and other interactions you want to apply. 
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Step 7: Associate Bookmarks with Buttons 

1. Go back to your report page and select the button you want to associate with a bookmark. 

2. In the "Visualizations" pane, find the "Button Text" section. 

3. Use the "Bookmark" dropdown to link the button to the corresponding bookmark. 

Step 8: Test Interactivity 

1. Switch to "View" mode to test the interactivity. Click the buttons you've created to navigate 

between different report states. 

Step 9: Save Your Report 

1. Once you've set up buttons and bookmarks to create interactive reports, save your Power BI 

project. 

Step 10: Publish Your Report 

1. If you want to share your interactive report or dashboard with others, publish it to the Power BI 

Service or export it to a shareable format (e.g., PDF). 

By following these steps, you can effectively create interactive reports and dashboards in Power 

BI using buttons and bookmarks. This enables you to build more engaging and dynamic reports, 

allowing users to navigate through different states and explore data in a more interactive 

manner. 

  



PowerBi 

26 
 

4.1 User Guide: Publishing, Exporting, and Sharing Reports in Power BI 

This step-by-step user guide will help you understand how to publish, export, and 

share your reports in Power BI. You'll learn how to publish reports to the Power BI 

Service, export reports to various formats such as PDF and PowerPoint, and share 

your reports with others. 

Step 1: Open Your Power BI Report 

Open the Power BI report that you want to publish, export, or share in Power BI 

Desktop. 

Step 2: Publishing Reports to Power BI Service 

1. Click on the "Publish" button in the Power BI Desktop ribbon. 

2. Sign in with your Power BI account if you're not already signed in. 

3. Select the workspace where you want to publish your report in the Power BI Service. 

4. Click "Publish" to upload your report to the Power BI Service. 

Step 3: Exporting Reports to Various Formats 

1. In Power BI Desktop, go to the "File" menu. 

2. Select "Export." 

3. Choose the format you want to export to, such as "PDF" or "PowerPoint." 

4. Specify any export settings as needed. 

5. Click "Export" to generate the file in the selected format. 

Step 4: Sharing Reports with Others 

1. In the Power BI Service, locate the report you want to share. 

2. Click on the report to open it. 

3. In the upper-right corner, click the "Share" button. 

4. Enter the email addresses of the people you want to share the report with. You can 

also choose whether they have view or edit permissions. 

5. Add a message or additional instructions if needed. 

6. Click "Share" to send an email invitation to the recipients. 

Step 5: Share a Link to the Report 

1. Alternatively, you can create a shareable link to the report in the Power BI Service. 

2. Click on the "File" menu in the Power BI Service and select "Publish to web." 

3. Choose the settings for the shareable link, including whether you want to allow 

public access or require a password. 

4. Click "Create embed code" to generate a shareable link or embed code. 
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Step 6: Share Reports via Email 

1. You can also share reports via email by clicking on the "Email" button in the Power BI 

Service. 

2. Enter the recipient's email address, a message, and select whether to attach the 

report or send a link. 

3. Click "Send" to email the report. 

Step 7: Collaborate with Others 

1. Collaborate with others on a report by sharing it within a workspace or app in the 

Power BI Service. 

2. Grant access to colleagues, allowing them to view or edit the report collaboratively. 

Step 8: Manage Sharing and Permissions 

1. In the Power BI Service, you can manage sharing and permissions for reports in the 

"Settings" or "Manage permissions" sections. 

2. Here, you can add or remove users, change their roles, or stop sharing the report. 

By following these steps, you can effectively publish, export, and share your reports 

in Power BI, making them accessible to your team, stakeholders, or the public in the 

formats and with the permissions you require. 
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4.2 User Guide: Creating Dashboards and Tiles in Power BI 

This step-by-step user guide will help you understand how to create dashboards and 

pin visuals to them in Power BI. You'll learn how to create dashboards, pin visuals to 

these dashboards, and include real-time data for a dynamic and insightful 

experience. 

Step 1: Open Your Power BI Report 

Open the Power BI report that contains the visuals you want to pin to a dashboard. 

Step 2: Create a Dashboard 

1. In the Power BI Service, click on the "Workspace" where you want to create a 

dashboard. 

2. Click on "Dashboards" in the left navigation pane. 

3. Click the "+ Create" button to create a new dashboard. 

4. Give your dashboard a name and description. 

5. Click "Create" to create the dashboard. 

Step 3: Pin Visuals to the Dashboard 

1. In the Power BI Service, open the report that contains the visuals you want to pin to 

your dashboard. 

2. Hover over the visual you want to pin, and you'll see a "Pin visual" icon (a pin) in the 

top-right corner of the visual. 

3. Click on the "Pin visual" icon. 

4. Select the dashboard you created earlier from the list, and click "Pin." 

5. The visual is now pinned to your dashboard. 

Step 4: Arrange Tiles on the Dashboard 

1. After pinning visuals to your dashboard, you can arrange and resize them as needed. 

2. Click on the dashboard you created to open it. 

3. Drag and drop the pinned visuals to arrange them on the dashboard canvas. 

4. Resize and customize the tiles as needed to create a layout that presents your data 

effectively. 

Step 5: Real-Time Data in Dashboards 

1. You can include real-time data in your dashboards for live updates. 

2. To do this, ensure that the data source you are using supports real-time data or uses 

a DirectQuery connection. 

3. Configure the data source to refresh at regular intervals or in real-time. 
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Step 6: Share the Dashboard 

1. To share the dashboard, click the "Share" button on the dashboard. 

2. Enter the email addresses of the people you want to share the dashboard with, and 

specify their permissions. 

3. Add a message if necessary, and click "Share" to send an email invitation. 

Step 7: Collaborate and Interact 

1. Collaborate with others by sharing the dashboard within a workspace or app. 

2. Users can interact with the dashboard, filter visuals, and explore data, making it a 

dynamic and insightful tool for data analysis. 

Step 8: Manage and Update Dashboards 

1. In the Power BI Service, you can manage and update your dashboards by adding, 

removing, or rearranging visuals as your data and reporting needs evolve. 

2. You can also update the real-time data settings to reflect changes in your data 

source. 

By following these steps, you can effectively create dashboards in Power BI, pin 

visuals to them, and include real-time data for a dynamic and insightful experience. 

Dashboards provide a centralized location to showcase critical data and share it with 

others in a meaningful and interactive way. 
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4.3 User Guide: Power BI Service Settings and Management 

This step-by-step user guide will help you understand how to work with Power BI 

Service settings. You'll learn about the overview of Power BI Service settings, 

managing data refresh schedules, and leveraging collaborative features and sharing 

options. 

Step 1: Access Power BI Service Settings 

1. Open a web browser and navigate to the Power BI Service (https://app.powerbi.com). 

2. Sign in with your Power BI account. 

3. Click on your user profile picture in the upper-right corner, and select "Settings." 

Step 2: Explore Power BI Service Settings 

1. In the Settings menu, you'll find various options and sections for configuring your 

Power BI Service experience. These may include: 

 General: Configure default settings, regional options, and the appearance of 

the Power BI Service. 

 Workspaces: Manage workspace settings and permissions. 

 Datasets: Configure data source settings and connections. 

 Scheduled refresh: Set up data refresh schedules and policies. 

 Security: Control security settings and access permissions. 

 Admin portal: Access additional admin settings and configuration options. 

Step 3: Managing Data Refresh Schedules 

1. Click on "Scheduled refresh" to access data refresh settings. 

2. Configure data source connections, refresh frequency, and notifications. 

3. Set up data source credentials and privacy options as needed. 

4. Define refresh policies, including data source priority and retry settings. 

5. Save your refresh schedule settings. 

  

https://app.powerbi.com/
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Step 4: Collaborative Features and Sharing Options 

1. To collaborate and share reports and dashboards with others, use the following 

options: 

 Workspaces: Create and manage workspaces for collaborative projects. Invite 

users to join workspaces, allowing them to collaborate on reports and 

dashboards. 

 Sharing: Share individual reports, dashboards, or entire workspaces with 

specific users or groups. Configure permissions to control who can view or 

edit content. 

 Embedding: If needed, use the "Embed" feature to generate code for 

embedding reports or dashboards in other applications or websites. 

 Apps: Create and publish apps that package reports, dashboards, and 

datasets together for easier distribution and consumption. 

Step 5: Save and Apply Settings 

1. After making changes to Power BI Service settings, be sure to save your 

configurations. 

2. In some cases, you may need to refresh or apply settings for changes to take effect. 

Step 6: Explore Advanced Admin Settings (Optional) 

1. In the "Admin portal" section or related admin settings, you can access advanced 

configuration options, including audit logs, usage metrics, and more. 

Step 7: Review and Monitor 

1. Periodically review and monitor your Power BI Service settings to ensure that they 

align with your data and reporting requirements. 

By following these steps, you can effectively manage Power BI Service settings, 

control data refresh schedules, and utilize collaborative features and sharing options 

to work more efficiently and share insights with your team and stakeholders. 
 

 

 


